WIS-PhagoTracker

Phago Kinetic Tracks Analysis Tool

Created by:
Ofra Golani\textsuperscript{1}, Meirav Galun\textsuperscript{1} and Suha Naffar Abu-Amara\textsuperscript{2}

In the laboratories of
Ronen Basri\textsuperscript{1} and Benny Geiger\textsuperscript{2}

\textsuperscript{1} Department of Computer Science and Applied Math
\textsuperscript{2} Department of Molecular Cell Biology
Weizmann Institute of Science
Rehovot, 76100 Israel

Authors (in alphabetical order)
Gilad Barkan
Meirav Galun
Ofra Golani
Yoav Karnieli
Eitan Sharon

Copyright 2006-2009 by Yeda Research and Development Company Ltd.
**WIS-PhagoTracker** is free for academic research. **WIS-PhagoTracker** is a property of Yeda Research and Development Company Ltd. It is intended for academic research only and is subject to the accompanying license agreement.

Please credit **WIS-PhagoTracker** in publications by citing the papers describing its underlying methods.

The very accurate tracks detection which is the core of **WIS-PhagoTracker** is achieved by using multi-scale segmentation algorithm [1] developed by: Ronen Basri, Achi Brandt, Meirav Galun, Yoav Karniel and Eitan Sharon (in alphabetical order), at the Department of Computer Science and Applied Mathematics at the Weizmann Institute, and patented in [2].

The high throughput cell migration assay [3] was developed in the laboratory of Prof. Benny Geiger.

## References

[1] E. Sharon, M. Galun, D. Sharon, R. Basri and A. Brandt,  
Hierarchy and adaptivity in segmenting visual scenes.  

[2] Achi Brandt, Eitan Sharon, Ronen Basri and,  
Method and Apparatus for Data Clustering Including Segmentation and Boundary Detection.  
U.S. Patent and Trademark Office Application No. PCT/US01/43991,  
July, 2003, assigned to Yeda Research and Development Co., Ltd.,  
Nov. 2000.

# Index

1 Index .......................................................................................................................... 3
2 Introduction .............................................................................................................. 4
3 Installation Instructions .......................................................................................... 5
4 Bird's-Eye View ........................................................................................................ 5
5 Quick Start ................................................................................................................ 7
6 Tracks Extraction Overview .................................................................................. 14
  6.1 Preprocessing ........................................................................................................ 16
  6.2 MultiScale Segmentation ..................................................................................... 17
  6.3 Find Candidate Paths and Cells ......................................................................... 18
  6.4 Track Detection ................................................................................................... 19
  6.5 Track Filtering ...................................................................................................... 20
  6.6 Result Files .......................................................................................................... 20
  6.7 Adjusting Parameters ......................................................................................... 21
7 Working with whole-plate and single files ................................................................ 21
8 View Results ............................................................................................................ 22
9 Manual Editing ......................................................................................................... 23
  9.1 Editing ................................................................................................................ 23
  9.2 Saving and loading manual values ...................................................................... 25
10 Statistical Analysis ................................................................................................. 27
  10.1 Statistics Type ................................................................................................... 28
  10.2 Gating ............................................................................................................... 33
  10.3 Plate Comparison ............................................................................................... 33
  10.4 Controlling Figure Appearance ......................................................................... 34
11 Batch Processing ................................................................................................... 35
12 Settings and Preferences ......................................................................................... 37
13 Miscellaneous ........................................................................................................... 39
2 Introduction

\textit{WIS-PhagoTracker} is a software application for quantitative analysis of high throughput cell migration assay developed in the lab of Prof. Benjamin Geiger. The cell migration assay [3] is based on a modified Phagokinetic tracks procedure, in which motile cells "leave their tracks" on a specialized surface. These tracks are visualized using a screening microscope.

\textit{WIS-PhagoTracker} enables morphometric analysis of such tracks. It uses state of the art multiscale segmentation algorithm [1], for fine detection of tracks and cells boundaries. Following the segmentation step, it quantifies various morphometric parameters for each track, such as track area, perimeter, major and minor axis and solidity. All these measures are calculated for each track in each well of a well plate and saved for further statistical analysis.

\textit{WIS-PhagoTracker} supports all the analysis phases starting from preprocessing, finding tracks of selected wells or a whole plate, through viewing the results and manually rejecting tracks to statistical analysis of the results. It also supports batch processing of several plates, and analysis of single image files.

The very accurate tracks detection which is the core of \textit{WIS-PhagoTracker} is achieved by using multi-scale segmentation algorithm [1] developed by: Ronen Basri, Achi Brandt, Meirav Galun, Yoav Karnieli and Eitan Sharon, at the Department of Computer Science and Applied Mathematics at the Weizmann Institute, and patented in [2].

All the data used in this user guide was collected by Suha Naffar Abu-Amara in the laboratory of Benny Geiger at the Department of Molecular Cell Biology at the Weizmann Institute.
3 Installation Instructions

1. Download and unzip WIS-PhagoTracker to any folder (e.g. C:\Program Files\PhagoTracker).
2. Download and run MCRInstaller.exe (see link on WIS-PhagoTracker website)
3. To start WIS-PhagoTracker, run PhagoTracker.exe. As it is a compiled Matlab application a command window is shown first and stays open all the time. It takes some time to de-compress the compiled Matlab exe file.

4 Bird's-Eye View

Analysis of phago kinetic tracks is based on accurate extraction of tracks, followed by statistical analysis of the tracks' features. Extracting the tracks manually is a very tedious work, which is not plausible for large amount of data. The aim of WIS-PhagoTracker is to enable automatic extraction of tracks, with very high accuracy of tracks borders. To overcome segmentation errors we provide means for rejecting non-tracks area which were detected as tracks (false-detect), or tracks who's boundaries were not recognized well.

The input is either single images or a whole plate data. Analysis of Phago-kinetic tracks data using WIS-PagoTracer is done as followed:

1. Tracks detection.

At this stage the images are preprocessed to correct for uneven illumination and enhance contrast. Multi-Scale segmentation finds candidate cell and paths segments and enables us to get the fine details of track's border. These candidate segments are then combined into track segments (optionally for a whole well, allowing the tracks to cross field border). The candidate tracks are filtered based on selected criteria, and are finally marked as confirmed or rejected.
Many measures are calculated for each track, such as: area, axial ratio, perimeter, solidity, roughness, etc. Detection can be done on a single file or a whole directory, a single well, well range or a whole plate. Batch processing of several directories or plates is also possible. In order to achieve high accuracy of tracks detection one should tune the parameters to the specific experimental setup. Parameter tuning is usually done on a small amount of data (few images or few wells).

2. **Viewing Results:** Results can be shown in several views: Original image (or well montage), Pre-Processed image, Detected tracks (confirmed tracks are shown in red, and rejected tracks in blue), and tracks with their skeleton. Result images can be enlarged and shown in separate figures for better view of big images and especially for well montages. The measures of a specific track's can be seen by clicking on the track.

3. As the detection process is not ideal and may have some errors, one can **Manual Edit** the results to reject tracks, and/or to measure track's end-to-end.

4. **Results are exported into excel files** for further analysis. **Statistical Analysis** of the results can be done for whole plates. One can choose many statistics types (histogram, mean, percentile, etc.) for any of the calculated measure. This is not supported for single files.
5 Quick Start

This chapter demonstrates working with whole-plates. Working with single images, or directory of single images is essentially the same, with some small differences. Please refer to chapter 7 for more details.

1. To run WIS-PhagoTracker, double click on PhagoTracker.exe (for example click on C:\PhagoTracker\Ver2_3_3\PhagoTracker.exe). The Main window will appear. Since it is a compiled Matlab application a command window will be shown first and will stay open all the time.

![WIS-PhagoTracker Main Window](image)

Figure 1: WIS-PhagoTracker Main Window

2. To load a plate, click the New Image button and select the image for analysis in the dialog opened. The Image will be shown in the Input Image panel. Its file name and path will appear in the Image Info panel (see Figure 1).

You can load whole plates (.r6d) or single image files in TIF or JPEG format.
3. **Set Work Directory.** The default location for single files is the location of the input file. For whole plates, where huge files are used, the default is to use another location. For example you can store your plates in \`d:\data\inputData\` and set work directory to \`d:\data\outputData\<Plate_Name>\`. Use the "..." button next to the *WorkDir* field to select a work directory. Shown in blue in Figure 1.

4. **To view available results** press the *Show Available Results* button.

5. **To browse through the wells,** use the arrows to select well and then press the *Select Well* button to display the well content. If you work with single files you need to switch to the whole directory mode.

6. **You can choose to process a single well or a range of wells by using the Single Well / Well Range radio buttons.** The default well range is the whole plate. You can change it to another contiguous range of wells by defining the first (*from*) and last (*to*) wells in the range.

7. **To Process the selected well,** press the *Run* button. All buttons and menu items are disabled until processing is done. The status of the process is shown in the *Status* panel on the right side of the window. Processing time depends on the nature of the specific image and on the chosen parameters. In general analysis of images with more tracks takes longer, and so does analysis of noisy images. It not recommended to **carefully tune the application parameters to the specific data.** For thorough explanation of the track extraction process please refer to the next chapter and the *Tips for Parameter Tuning* document (invoked through the help menu).

Press the *Stop* button to stop processing.
8. Once processing is done you can **view the results**. You can toggle between different views of the results using the radio buttons in the *Display* panel. (see Figure 2).

![Figure 2: Display Results](image)

The default display is the *Tracks Perimeter*. The available views are:

- **Original image**: The original unprocessed well.

- **PreProcessed Image**: The preprocessed well that is input to the segmentation algorithm. It is important that you verify that the tracks are clearly visible in that view; otherwise there is high chance that the tracks will not be detected properly. If they are not clear enough (e.g., image is too dark, there is very low contrast between tracks and background, etc.) you should tune the preprocessing module. See chapter 6 and the *Tips for Parameter Tuning*.

- **Candidate Paths and Cells**: Candidate path segments are shown in blue, candidate cell segments are shown in orange. This is an intermediate stage.
in the track detection process. It is available only if the *Save Candidate Path/Cell Montage Files* checkbox in the parameters window is checked during processing (in the *Tracks Detection Parameters panel*).

- *Tracks Perimeter:* The perimeter of all detected tracks is shown. Confirmed tracks are shown in red. Rejected tracks are shown in blue. The cells border is shown in green.

- *Tracks Skeleton:*

You can show cell labels by checking the *Show Cell Labels* checkbox.

To **zoom-in** on a well to see the detailed tracks, click the *Separate Figure* icon underneath the image (in blue color in Figure 2).

![Figure 3: Zoom-In](image)

This will display the zoomed-in well in a scroll panel together with overview panel (see Figure 3). The rectangle in the overview panel shows the portion of the well that is currently visible in the scroll panel. Move the rectangle in the
overview panel to view portions of the well that are not currently visible in the scroll panel.

To see the information of a specific track press the *Show Track Information* icon in the toolbar and left-click on the desired track. A pop-up menu with the entire track's information will appear (see Figure 4).

![Figure 4: Track Information](image)

Right-click and choose *Delete All Datatips* to clear the display.

Per track measurements are shown in the *Tracks Information* table on the bottom right side of the window, and include the following:

- *TArea*: Total track area
- *NArea*: Net area = *TArea* – area of cells in the track
- *Minor Axis*: the length of the minor axis of the ellipse that has the same normalized second central moments as the region
- **Major Axis:** the length of the major axis of the ellipse that has the same normalized second central moments as the region

- **Axial Ratio:** \( \frac{Major\text{ Axis}}{Minor\text{ Axis}} \) (always \( \geq 1 \))

- **Perimeter:** the distance around the boundary of the track

- **Solidity:** Scalar specifying the proportion of the pixels in the convex hull of the track that are also in the track.

- **Roughness:** \( \frac{(\text{Perimeter}^2)}{(4\pi \times \text{TArea})} \)

- **SkelLen:** the length of the track's skeleton

- **nCell:** number of cells detected in the tracks.

- **Confirm:** automatically confirm value

- **Manual Confirm:** manual confirm value. The manual confirm value is initialized with the confirm value, and change upon manual accept or reject. 0 stands for rejected track, 1 stands for confirmed tracks.

- **ManualConfirmDone:** a flag indicated if the track was handled manually

- **E2EDist:** End-to-End distance, measured manually.

- **TArea/NCells:** average area per cell

- **TArea/NCells:** average net-area per cell

Overall image measurements are shown in the *Image Information* table on the bottom left side of the window, and include the following:

- **Well_i:** well first (y) index.

- **Well_j:** well second (x) index.

- **nTracks:** total number of detected tracks in the well.

- **nConfirmedTracks:** number of confirmed (automatically) tracks.

- **nManuallyConfirmedTracks:** number of manually confirmed tracks.
- \( \{m/s\}\{a/c/r\}_\text{measure} \) Mean and standard deviation for all tracks, manually confirmed and rejected tracks, of the tracks measurements

All the measurements are in the units (or squared units for area) defined in the Units panel of the parameter window (see Figure 6)

9. Results are saved into two files: Averaged Results File includes one line for each well with the content of Image Information table, and an additional line with average over all wells (if a range of wells was processed). The Detailed Results File includes one line for each detected cell, in each processed image, with the content of Tracks Information table. The files are placed under WorkDir\Output Suffix Dir\File Name. Their default names are set using Edit->Settings menu. They can be saved either Excel format (.xls) or comma separated text file (.txt), and can be opened with Excel for example. Thus, for the example shown in Figure 2 the Average Results file will be in:

G:\Ofra_Data\Data\Suha\OutputData\SA-31May09-HOMOLOGS1A\output\ AvgResults.xls

10. To exit WIS-PhagoTracker, click on the File menu on the upper right side of the window, and choose the Exit item.
6 Tracks Extraction Overview

A typical input is a 96-well plate, in which each well is covered with 25 (5*5) fields.

The processing of each well in such plate is shown in the Figure 5.

- **Pre-process** all fields of the well to correct for uneven illumination, enhance contrast and convert to 8bit, as the segmentation algorithm supports only 8bit images.
- Perform **Multi-Scale Segmentation** on each field
- **Find candidate paths and cells** by selecting significant segments
- Create montage of all the fields
- **Find candidate tracks** by combining cells and paths. Candidate tracks can cross field borders.

Figure 5: Tracks Extraction Process
- **Filter out tracks** based several criteria such as tracks with no cells, tracks with more than one cells, border tracks, etc.

To control processing use the Parameters window, which is invoked through the Edit menu.

![The Parameters Window](image)

**Figure 6: The Parameters Window**

The rest of this chapter describes in details each of the processing stages.

Copyright 2006-2009 by Yeda Research and Development Company Ltd.
6.1 Preprocessing

At this stage we enhance the input image, and convert it into a format suitable for the multi-scale segmentation algorithm. This process is shown in Figure 7.

![Preprocessing Process Diagram]

In the following description and throughout this user guide, parameters are shown in Italic font.

Resize (for fields larger than 1024*1024) always if needed

Convert to grayscale always if needed

Illumination Correction optional

- Estimate the illumination image as the median of pixels in 64*64 pixels blocks
- Interpolate the illumination image to full size
- Divide each pixel of the original image by the relevant pixel in the illumination pixel
High-pass filtering  
- Estimate the average image as the average of 100*100 pixels around each pixel
- Remove the average image * High Pass Filter Factor from the original image

Low-pass filtering  
- Replace each pixel by an average of the 3*3 pixels block around it.

Contrast Adjustment  
- A histogram of pixel values is created for the field or whole well. Pixels whose value is below a given low percentile (Adjust Contrast Tolerance Low Value) are clipped to that percentile value. Pixels whose value is above a given high percentile (Adjust Contrast Tolerance High Value) are clipped to that percentile value.

Convert to 8bit:  
- scale by Scale Max Percent * Field max or Well max (default)

The order of pre-process stages is fixed

Basically the above process is done on each field separately, except for the case of contrast adjustment and scaling to 8 bits, which can be done using the whole well values.

### 6.2 MultiScale Segementation

This is the core part of the track extraction. It is based on a novel multiscale segmentation algorithm [1], [2]. Segmentation is done for each field separately.

The module parameters are:
- Run Segmentation / Use Existing - when checked segmentation is done. As segmentation takes considerable amount of time, you might want to run it only once during parameter tuning. To do so, you will need to check the Save Segments .mat File option.
- Save Bin File - This is a debug option. The user should always keep this option unchecked.
The following segmentation parameters are usually good, and should be changed from the default values: *Fine Coef, Average Coef, Intensity Variance*.

### 6.3 Find Candidate Paths and Cells

Tracks are composed of cells which are darker than the background and the area that the cells cleaned while moving around which is brighter than the background. At this stage significant cell and path segments are selected from all available segments of the multiscale segmentation. This stage is done for each field separately.

Each segment has Intensity and Saliency associated with it. Significant segments have lower saliency. Path segments should be brighter than the background and cell segments should be darker than the background. Both should be more significant than the average, but cell segments tend to be more significant (lower saliency) than path segments.

Several methods for selecting the segments are implemented, but the combination that works the best is:

**Intensity Thr Type**: Mean Int + Factor * Std Int – The average and standard deviation of the intensity of all segments is calculated. Path segments should have intensity higher than the average + *Path Intensity Std Factor* * Std. *Path Intensity Std Factor* should be positive, and *Cell Intensity Std Factor* that play a similar role for the cell segments, should be negative.

**Saliency Threshold Type**: Mean Saliency * Factor – The average saliency is calculated. Path segments should have saliency lower than the average * Path Saliency Factor. Cell Saliency Factor* plays a similar role for cell segments.

**Min Cell Segment Size**: The minimum size of cell segment. This is not the minimum cell size, as cell can be composed of several cell segments (see Track Detection).
See Help ⇒ Tips for Parameter Tuning for more details.

6.4 Track Detection

This stage is done for the whole well after stitching the fields into a big montage. This enables us to include tracks which cross the border between two neighboring fields.

At this stage cell and path segments are combined to form tracks. The process is as followed:
- Holes in cell segments are filled.
- Adjacent cell areas are combined and labeled.
- Remove cell segments that are too big (Max Cell Size) or too small (Min Cell Size)
- Raw cell and path segments can be saved for debugging and tuning (check Save Candidate Cell/Path Montage). It is not needed otherwise, and unchecking this option will save disk space.
- Adjacent cell and path segments are combined together.
- Holes in the tracks are filled.
- Labeled cells are related to tracks to enable counting the number of cells and calculating cell area
- Cell-only tracks (ie tracks where that do not include any path segments) are discarded. This is controlled by the Discard "cell-only" tracks.
- Small tracks are discarded. This is controlled by the Discard small tracks option.
- Tracks properties are measured: Area, Perimeter, MajorAxis, MinorAxis, Solidity
- Skeleton is calculated for all tracks. This is controlled by Compute Skeleton. The default method to be used is "Thining" which usually gives better results than the alternative "skeleton" option. You can avoid calculating the skeleton by choosing "none".
Temporary results of this stage are usually saved to allow for running only the filtering stage later on. Uncheck Save Candidate Tracks Temporary files to avoid saving them.

6.5 Track Filtering
At this stage several criteria are used to reject non-valid tracks. The results are saved for statistical analysis and visualization. The perimeter of each track is drawn on top of either the original or the preprocessed image (Overlay Original / PreProc Image). Confirmed tracks are shown in red, rejected tracks are shown in blue. The perimeter of cell areas inside the track is shown in green.

Running the filtering stage is controlled through the Parameters window. The filtering parameters are controlled from the main window.

The following filtering criteria can be used:
- Reject small tracks (Min Track Size)
- Reject big tracks (Max Track Size)
- Reject tracks that whose border is too rough. This is done mainly to reject tracks that are falsely detected on the corner of the image out of the well area. (Max Roughness Value)
- Reject tracks which touch the border of the image. It is assumed that such tracks are only partially shown in the image, and thus should be avoided. (Filter Tracks on the Border)
- Filter Tracks without Cells.
- Filter cells with more than 1 cell.

6.6 Result Files
Several results files are saved for each well/image. They are created in the WorkDir\OutputDirSuffix\OutputSubDirSuffix folder. They include all the visual results and measurements and can take considerable disk space. If you remove them, the application will not be able to show the visual results and the measurements.
Segments.mat files which may be saved temporarily to save time during parameter tuning, are saved in the WorkDir\OutputDirSuffix folder, and can be removed (see section 6.2).

6.7 Adjusting Parameters
See Help ⇒ Tips for Parameter Tuning.

7 Working with whole-plate and single files

WIS-PhagoTracker can process single files as well as a whole plate representing many experiments. Handling both types of input differ in the following aspects:

Default WorkDir
For single files, the default working directory is the input directory, where the images are. Whole-plates are saved in huge files, therefore the default is that they working directory is different from the input directory where those files are saved.

Track extraction
A single well in a whole plate can be represented by a montage of several images (fields), all of which are processed together and a proper montage is created. Scaling can be done using the maximal value over all fields of the montage. Tracks can cross field border.
In single file mode, one can process all images in a given directory, but each image is independent of the other images in the directory.

Browsing
When browsing through a plate, one should select the requested well either using the arrows, or by entering the well index, and then press the Select Well button. Use the arrow buttons to browse through single images in a directory.
Selecting wells/images for processing

For whole plate you can choose to process (using the Run button) either a single well or a contiguous range of wells. The default range is all available wells in the plate. You can change it to another contiguous range of wells by defining the first (from) and last (to) wells in the range.

When working with single images, if the Single Image radio button is selected, then only the current image is processed. If the Whole Directory radio button is selected then all the images in the directory are processed when pressing the Run button.

Manual Editing of a well from whole-plate can be done only in a separate window. For single files it can be done in the main window as well.

Statistical Analysis is supported only for whole plate.

8 View Results

In chapter 5 we explained how to select the display, zoom in and view track information.

You can adjust the contrast of the current image by pressing the Adjust Contrast button. A new window will open and will allow you to change the displayed data range. The easiest way is to use the mouse to drag the red lines to the desired value. The image is updated on the screen as you do it. This can be done only for grayscale images, and hence only in original and preprocessed views.
9 Manual Editing

9.1 Editing

Tracks detection is quite good in general. However, it is not perfect and there are cases when one wants to reject a track. Such cases are for example:

- Track border is not detected correctly.
- Two cells are identified as one cell and hence the track was not rejected
- Some garbage was detected as a track. This happens mainly on the well borders, most of them are automatically rejected, but few are confirmed and need to be rejected manually.

In such cases, one can change the automatic decision and choose to reject a track.

Rejection can be done only for perimeter or skeleton view and only in a separate figure for whole-plate. You can reject single track or specify a whole region that you want to reject.

**Reject / Accept single track:** Right click on the track, a context-menu will open (see Figure 9), that will allow you to accept or reject the track (based on its current status). Select the required option to accept/reject the track. The track will change its color, but note that this may take some time in case of a whole well, so be patient.

Also note that this does not work if the *Show Track Information* button is pressed, so make sure that this button is turned off.

**Reject a whole region:** Press the *Select Region to Reject* icon. The cursor will change to a cross hairs + when over the image. Click and drag the mouse to define the vertices of the polygon and adjust the size, shape, and position of the polygon. When you are done, double click so that the polygon will close-up by connecting the first vertex with the last one. Right-click to invoke the context menu, which will allow you to *Reject All Tracks* that part of them is
inside the polygon. To cancel choose the Delete option. The following figure shows a polygon being created. See Figure 8.

![Figure 8: Rejecting a whole region](image)

**Measure End-to-End distance:**
Right click on the track, a context-menu will open, choose *Measure End-to-End*. A distance tool will show up. You can drag its end points to the desired position; the length of the line is shown and updated while you do it. When you are done, place the pointer on the distance tool and right-click. A context menu will show up, choose the *Save End-to-End Measure* to save the measured distance, choose *Delete* to cancel.

![Figure 9: Measuring End to End](image)
9.2 Saving and loading manual values

All the manual values are saved internally for the whole plate/directory. You can switch to another well/image in the plate/directory with no worry. When you switch to a well that already has manual values, its visual and tabular results are updated accordingly.

To save the values into a file, use Save Manual Values from Manual Edit menu. It is recommended that you'll save them into a file frequently. If values are not saved, the application will suggest saving them when you try to load a new image (using the New Image button) and when you try to exit the application.

To load existing values use the Load Manual Values from Manual Edit menu.

The default location for the manual values file is WorkDir\OutputDirSuffix, and the default file name is <plate_name>_Manual.mat, or <dir_name>_Manual.mat

If the default manual values file exists the application will suggest loading it when you load statistics or on your first manual edit in the current session.

All manual values of a plate/directory are saved in one file. You cannot load manual values incrementally.

Many times you will not do all the manual editing of a plate or directory at single session. To see which wells / files you already edited use Show Details from the Manual Edit menu. It is recommended that you finish editing a whole well or file in one session.

When you load a manual value file, the images and tables of the current well/image are updated. However to make editing more convenient such
update is not done during editing. To update the display tables use the Update Display Tables from the Manual Edit Menu.

The visual results are updated inside the application when you browse through wells and files. They visual results files that are saved in the WorkDir\OutputDirSuffix\OutputSubDirSuffix folder are not changed. If for some reason you would like to save the updated files, you can do so by choosing the Save Updated Perimeter Image from the Manual Edit menu.
10 Statistical Analysis

Statistical analysis is supported only for whole plates.
To perform the analysis you first need to load statistics. You do it by choosing Load Statistics from the Statistics menu. If the default Manual Values file exists, the application will suggest loading it. If Manual values are saved in another file, you can update the statistics by choosing the Update Stat with Manual Values from the Statistics menu.
If Manual values are already loaded, the statistics is updated automatically.

When statistics is loaded, choose Analysis... from the Statistics menu. The Statistics window will be opened (see Figure 10)

Figure 10: The Statistics Window
A rich set of features (measurements) is saved for each track in each well. The statistical module enables evaluation of the variation in track's features following the different treatment applied to each well. Several statistics of each measured feature can be displayed for each well or series of wells (for example histogram, average).

In addition one can compare the accumulated histogram for each measured feature to the respective accumulated histogram of the tracks in the control wells to get comparison scores using the Wilcoxon Rank-Sum and the Kolmogorov-Smirnov tests.

10.1 Statistics Type

You can view a summarized statistics of a whole plate, or detailed statistics of selected series of wells. A series of wells is a contiguous rectangle of wells, defined by its first (upper left) and last (lower right) wells. You define the series of interest through the Series Definition panel, where you can add a series and set its range and name, remove series and set the control series.

The following Graph types are supported:

- **Plate view** – Plate summary of the scores (plate scores) is displayed in spectral-color code. The color scale is set by the mean and standard deviation of the scores for individual wells. When **Scaling By all control wells** is used the mean value of the score in the control wells is used as the center (green) of the color scale, while the larger/smaller values indicates the range (red to blue). If no Scaling is used then the mean of score over all the wells is used as the center (green). Figure 11 shows a plate view of the average (mean) Total Area of manually confirmed tracks in each well.

You can view the specific values of a certain well by pressing the button on the toolbar and clicking on the desired well.
Figure 11: Plate view of average Total Area of manually confirmed tracks

- **Histogram** – The histogram of values of the selected feature is plotted for each active series. You can set the number of bins in the histogram using the *Number of Histogram Bins* field (which appears in the place of the percentile field when you choose the Histogram graph type). Figure 12 shows the histogram of total area for the control well (1,2) and for wells: (2,2), (3,3), (3,4) and (5,9).

- **Cumulative Distribution Function (CDF)** – the empirical cumulative distribution function of the selected feature is plotted for each active series. Figure 13 shows the cumulative distribution of the same series shown in Figure 12.
Figure 12: Histogram of Total Area

Figure 13: CDF of Total Area
- **Scatter plot** – a scatter plot of the two selected features is shown for each active series. Figure 14 shows an example of a scatter plot of Roughness against Total Area of three of the above series.

![Figure 14: Scatter plot view of Roughness against Total Area](image)

**Feature**: You can select on which of all the calculated measures you want the statistics

**Statistics Type** is the score calculated for each well for Plate View. Two types of scores are provided. The first one calculates the score of each well independently. These scores are: The **number** of tracks in each well (num), **average** of the selected feature (mean) over all tracks in the well, **standard deviation** of the selected feature (std), **median**, and **percentile**. The percentile can be controlled using the Percentile field.

It is a good practice to display the plate view of the Number (Num) of manually confirmed tracks in each well.

The second type of scores is comparative scores, which compare the distribution of the selected feature in each well against the distribution of that
feature in all control wells. The distributions can be compared either by the Kolmogorov-Smirnov test or by the Wilcoxon Rank-Sum test.

**Understanding p-Value:**

**Plate view:**

Kolmogorov-Smirnov (KS) p-Value: larger p-values indicate that the distribution is more similar to that of the control series.

KS decision: A threshold of 0.05 is implied to the p-value figure every well whose p-value is above 0.05 is decided to be of the same distribution as the control wells and is colored by red. Every well whose p-value is below 0.05 is decided to be of a different distribution and is colored by green. See Figure 15

![Figure 15: Kolmogorov-Smirnov p-Value (left) and decision (right)](image)

Histogram and CDF view: a triplet \((h,p,k)\) is associated with each series, where:

- \(k\) is the value of the kolmogorov-smirnov test,
- \(p\) is the asymptotic p-value \(p\).
- \(h\) is the decision: 0 if the distribution is the same as that of the control wells, 1 if it is different. Decision is made based on the a threshold on p-Value: 1 if p-Value > Significance Level, 0 otherwise.

Copyright 2006-2009 by Yeda Research and Development Company Ltd.
In the example shown in Figure 13, the values for the tracks in well (2,2) are (0,0.44,0.113) which means that the distribution of those tracks is the same as those of the control tracks and the p-value of 0.44 according to the KS test. On the contrary for the tracks in well (5,9) we get the values of (0,0.00175,0.176) which means that according to the KS test they came from a different distribution than the control tracks, and the p-value is 0.00175.

10.2 Gating
One can optionally filter the data based on two features. This is done by through the gating panel. For example you can examine the differences between large and small tracks by gating the tracks by Total Area.

10.3 Plate Comparison
If you repeat your experiment twice and have two plates with identical experimental setups, you can compare them to see how they fit each other. For this, you need to:
- Process both plates,
- Load the statistics of one plate as usual
- Set the parameters of the second plate in the Compare Against panel.
- Load the statistics of the second plate using the Load Statistics button.
- By using the Compare Display menu, you can choose to either:
  o Display the statistics of each plate in a different figure
  o Display the Histogram or CDF of both plates on the same figure, or
  o Display a comparison plate, in which each well in one plate is compared
- Check the Compare Plates checkbox and press the Display Statistics button.
10.4 Controlling Figure Appearance

You can control the appearance of your figures in the following ways:

- To display the values of the scores for each well in a plate view, check the *Show Values on Plate* check box.
- You can define your experimental setup in an excel file, in which you specify a short string for each well. To load it the plate definition file, click on the "..." button next *Definition File* in the *Plate Definition* panel. To show the definition in the plate view, check the *Show Plate Definition* checkbox.
- You can choose to display or omit the KS-test values in the legend of Histogram and CDF views, using the *Display p-Value in Legend* checkbox.
- You can control the appearance of your figure by clicking the *T* button in the figure toolbar. A window will open and let you change the title, subtitle, x and y labels, x and y limits and line colors of the figure.
11 Batch Processing

Batch Processing enables processing several plates or directories of single files at once. You can choose different parameters for each plate (or directory).

This is helpful in cases where you have several plates that you need to process, or several parameters setups that you want to check and you don't want to run them manually from the GUI one after the other.

As always, it is recommended that before running a whole plate in a batch you first tune the parameters for on one or few wells.

To run several setups in a batch you need to create a list of all the required setups, this is called a Batch List. Once you have such a list you run it sequentially. WIS-PhagoTracker will process one item in the list at a time, load the plate and set all the parameters. When done it will move to the next item on the list.

Create a Batch List

Start with the first setup you want to run, choose the parameters, when you are satisfied with the results you get, you can add it to the batch by using Add to Batch List from the Batch Processing menu. You can then load another plate, tune the parameters and then add the new setup to the list.

If the current batch list is not empty, and you want to create a new batch list, choose Create New Batch List from the Batch Processing menu.

Saving and Loading a Batch List

You can save your batch list into a file using the Save Batch List to File from the Batch Processing menu. You can load it later using Load Batch List from File.

The default batch list filename can be set using Default Batch Name in the Settings Window (see Figure 17).

Copyright 2006-2009 by Yeda Research and Development Company Ltd.

35
**View Batch List**

To view the content of your batch list and edit it choose *View Batch List...* from the *Batch Processing* menu. The Batch list window will show. The batch items shown in Figure 16 are all involved with the same plate and differ only by the processing parameters.

![Batch List Window](image)

**Figure 16: The Batch List Window**

The *Batch List Overview* table shows summary info of each batch item. The *Batch Items Details* table shows the parameters of the selected batch item.

Using the Batch List window, you can remove the selected batch item or set it as the active setup by pressing the proper button.
Run a Batch List

To run all items in the batch list sequentially select the Run Batch List from the Batch Processing menu.

You can choose to run only the first well in each plate (or first file in each directory) or all the wells (files) of the plate (directory). You set this using the Wells to Process control in the Settings Window (see Figure 17).

12 Settings and Preferences

The Settings window allows you to control some additional application settings. Choose Settings from the Edit menu to set:

- default Image, work directory, preferences and batch list location,
- Results File names and format, and the type of tracks for which results are saved (all, manually confirmed or automatically confirmed)
- Control of batch processing
- Color to grayscale conversion scheme.
- Manual Edit …

You can save all parameters and settings into preferences file, which can be loaded later on. Typically it is useful to have different preferences file for each experimental setup.

Use Load Preferences and Save Preferences from the File menu for this.

On startup the application loads the default preferences file from the directory it is launched from (if exist). You can set WIS-PhagoTracker defaults by saving your preferences in that directory.

You can get back to the default parameter setting by choosing Restore Default Parameters from the File menu.
Figure 17: The Settings Window
Choose *Restore Run Parameters* from the *File* menu to view and set the *WIS PhagoTracker* parameters to the parameters used in the last run (in a given work directory).

### 13 Miscellaneous

You can close all the opened figures – either images or graphs – by choosing *Close All Figures* from the *View* menu.